GeoGebra: Introduction
GeoGebra is an educational software package which combines geometry and algebra as equally important partners.  You can do constructions including points, vectors, segments, lines, and conic sections as well as functions, which can be altered dynamically by mouse afterwards. On the other hand, also the direct input is possible (such as g: 3x + 4y = 7 or c: (x – 2)2 + (y – 3)2 = 25), and a range of commands including differentiation and integration are at your disposal. The most remarkable feature of GeoGebra is the dual view of objects: every expression in the algebra window corresponds to an object in the geometry window and vice versa.

Go to www.geogebra.org.  Click on WebStart on the left-hand column of options.  Then Click on the button GeoGebra WebStart.  It is recommended to use GeoGebra WebStart which guarantees that you are always running the latest version of GeoGebra, eliminating complicated installation or upgrade procedures.  Note that you can also download the program in case you want to work offline.
After starting GeoGebra, the window depicted below appears.  By using the construction tools (modes) in the toolbar you can do constructions on the drawing pad by using the mouse.  At the same time the corresponding coordinates and equations are displayed in the algebra window.  The input text field is used to enter coordinates, equation, commands and functions directly; these are displayed in the drawing pad immediately after pressing the enter key.
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Some Basics
	1. View Menu:  Within the view menu there exist several toggle switches that open and close different display options.  A check mark next to each option means that this option is active.  A simple mouse click will toggle this on or off.  
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	2. Buttons:  

· When clicking on each button users should be able to see that the coloration of the button itself changes to indicate that it is active. 

· Only one button can be active at a time.
· Dropdown arrow exposes more options contained within each button. 
· The tools contained in each of these buttons are grouped.
· Once a tool from the dropdown arrow has been activated the icon on the button will change to show this newly selected tool.
· Note: The last tool used from each button will still show on the button.  If a user wishes to use this tool again later it is not necessary to select the dropdown arrow to select it as long as its icon is still showing.  Simply click the button to activate the last tool used in that group.
3. Pointer Button: 

[image: image1.emf]Think of this as home base.  If you want to get out of a mode click the pointer button, or press esc on your keyboard.  
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	Click the arrow on the bottom right side of the button to see a list of the options within that menu.
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	4. Mode:

On the bottom left hand side of the screen you can always see what mode you’re in.
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Example 1:  Play around!  Practice plotting points, construct a line segment, construct a circle, construct a line, change the labels on points, hide labels on objects, and create a title for your sketch.
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Example 2: Circumcircle of a Triangle

Task: Plot a triangle A, B, C and construct its circumcircle using GeoGebra.
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Construction using the mouse

	[image: image7.emf]
	1. Choose the mode “Polygon” from the toolbar (click on the small arrow at the third icon from the left). Now click on the drawing pad three times to create the vertices A, B, and C. Close the triangle by clicking on A again.

	[image: image8.emf]
	2. Next, choose the mode “Line bisector” and construct two line bisectors by clicking on two sides of the triangle.



	[image: image9.emf]
	3. In the mode “Intersect two objects” you can click on the intersection of both line bisectors to get the center of your triangle’s circumcircle. To name it “M”, click on it with the right mouse button (Mac OS: ctrl-click) and choose “Rename” from the appearing menu.

	[image: image10.emf]
	4. To finish the construction, you have to choose the mode “Circle with center through point” and to click first at the center, then at any vertex of the triangle.

	[image: image11.emf]
	5. Now choose the mode “Move” and use the mouse to change the position of any of the vertices – you will experience the meaning of “dynamic geometry”.

	
	6. Save your file if you wish.  Select from the File Menu, Save or Save As.  This will save the file as a GeoGebra file.  We will also see later how to Export a GeoGebra sketch to html so that you can post it on a website.


Some tips

· Try the “Undo” button on the right side of the toolbar.

· To hide an object, right click on it (Mac OS: ctrl-click) and uncheck “Show object”.

· The appearance of objects (color, type of line, ...) can be changed easily: just use the right mouse button (Mac OS: ctrl-click) again to click on the object and choose “Properties” from the appearing context menu.

· In the menu “View” algebra window, axes, and grid can be hidden or shown.

· In order to change the position of the drawing pad, choose the mode “Move drawing pad” and simply use the mouse to drag it.  [image: image12.emf]
· The menu “View – Construction Protocol” provides a table listing all the steps you took while doing your construction. This allows you to redo the construction step by step by the use of the arrow keys, and also to modify the order of various steps afterwards (see menu “Help” of the construction protocol). Moreover, you are able to use the menu “View” to hide or show unwanted columns.

Construction using the input text field

We are now going to do the same construction as above using the input text field, so you will need a new drawing pad (menu “File – New”). Then, type the following commands into the input text field at the bottom of the screen and press the enter key after every line.

A = (2, 1)

B = (12, 5)

C = (8, 11)

Polygon[A, B, C]

line_a = LineBisector[a]

line_b = LineBisector[b]

M = Intersect[line_a, line_b]

Circle[M, A]

Some tips

· Automatic completion of commands: after entering the first two letters of a command, it will be displayed automatically. If you want to adopt the suggestion, press the enter key, otherwise just continue typing.

· It is not necessary to key in every command, you can also choose it from the list of commands that is found at the right next to the input text field.

· Clicking at the icon “Input” (bottom left) activates the mode “Input field”. In this mode you can click on an object from the algebra window or drawing pad to copy its name into the input text field.

· For more tips concerning the input text field click on the question mark in the bottom left corner.

· You will obtain especially good results from your work with GeoGebra by combining the advantages of both input forms, mouse and input text field.

Example 3:  Area & Perimeter of a Triangle
· [image: image13.emf]  Use the Polygon tool to construct a triangle ABC.

· Double-click on the points A, B, C in the Algebra window to change them to be integer coordinates for a right triangle.

· What is the name of the value of P that is displayed under dependent objects?  

· Rename the Polygon right-clicking (Mac OS: ctrl-click) on the interior of the triangle.  Select Rename from the drop-down menu.  Rename the Polygon to AreaP.

· To calculate the perimeter of the triangle, we will use the Input Field at the bottom of the screen.  Type:  Perimeter=a+b+c.  Notice that a, b, and c are the side lengths of BC, AC, and AB respectively.

· Let’s display the value of the Area and Perimeter in out Geometry Window.  When we move the vertices of our triangle, these values will change in both the Algebra and Geometry windows.

· [image: image14.png]ABC



Select the Text Tool.  

· Click in the Geometry window.  Type:  “Area =” + AreaP

· You must use the quotes and the + symbol

· Click again in the Geometry window.  Type:  “Perimeter=” + Perimeter

· [image: image15.emf]Move the vertices of your triangle and watch the values be updated.
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Now, let’s create a sketch that shows that the area remains unchanged if we create one vertex of our triangle on a line that is parallel to the base of our triangle.

	1. Open a new window.
	

	2. 
[image: image17.png]


Draw a line segment AB.

 
[image: image18.png]


Construct a point that is not on the line segment AB.
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	3. 
[image: image20.png]


Use the parallel line tool to construct a line that passes through point C and is parallel to segment AB.

	4. 
[image: image21.png]


Use the point tool to construct a point D on the line.  

	5. [image: image22.emf]Select the Polygon tool and construct a triangle through points A, B, and D.  

6. Rename the polygon P to AreaP by right-clicking (Mac OS: ctrl-click) in the inside of the polygon and select Rename from the drop-down menu.  

	7. [image: image23.emf]Drag vertex D of the triangle using the point tool along the parallel line.  What do you notice about the area of the triangle?  Why is this?  Think about how you compute the area of a triangle.
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Example 4:  Linear Equations
Task:  We will enter a linear equation using the Input field and learn to create sliders for the 
values of the slope and y-intercept.

	1. Open a new window.


	

	2. In the Input field at the bottom of your screen, type:  y1: y=3*x + 5.  You must put the * symbol (or a space) for multiplication.  When you press enter the line will appear in the Geometry window and the equation appears as a free object.
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	3. Create a variable for slope and y-intercept.   In the Input field, type:  m=2 (press enter) and type:  b=1 (press enter).


	

	4. Now we will change our equation for y1.  Right-click (Mac OS: ctrl-click) on the equation y1 in the Algebra window.  Select Redefine.  Now change the equation to:  y1: y = m*x + b (press enter).  
Note:  You will need to type the * symbol for multiplication.  
Notice that the equation changes to a dependent object.
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	5. [image: image27.emf]  Select the Move tool.  Click on the free object m=2 in the Algebra window.  Use your keyboard up and down arrow keys to change the value of m.    

	6. We will now create a slider bar for each of m and b.  
Right-click (Mac OS: ctrl-click) on m in the Algebra window and select Properties from the drop-down menu.

· Check the box:  Show object

· For the Interval, type -5 for minimum value and 5 for maximum value.

· Change the increment to 0.2

· Click Apply

Repeat these steps to create a slider for b.

Note:  There is also a slider tool  
[image: image28.png]


 which is one of the options under the 6th button from the left.  
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	7. [image: image30.emf] Select the Move tool and change the values of m and b using the sliders.
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	8. Let’s save this document so that we can post it on a website in the future.

First, create a folder on your computer or flash drive where you would like to save your work.  

Secondly, from the File Menu, select Export, Dynamic Worksheet as Webpage (html), and then complete the dialogue box with something similar to the screen at the right.

Click Export.

Be sure to save your document in the folder you created above.

When you export, there are 5 files that are saved.  You will need all 5 files when you are ready to post your file to a website.
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Example 5: Tangents to a circle

Task: Using GeoGebra, construct the circle c: (x - 3)² + (y - 2)² = 25 and its tangents through the point A = (11, 4).
[image: image33.emf]
Construction using input text field and mouse
	
	1. Insert the equation of the circle c: (x - 3)² + (y - 2)² = 25 into the input text field and press the enter key (tip: the exponent can be found in the list to the right of the input field.)

	
	2. Enter the command C = Center[c] into the input text field.

	
	3. Construct the point A by keying in A = (11, 4).

	[image: image34.emf]
	4. Now choose the mode “Tangents“ and click on the point A and the circle c.

	[image: image35.emf]
	5. After choosing the mode “Move“, drag the point A with the mouse and observe the movement of the tangents. 

You should also try to drag the circle c and have a look at its equation in the algebra window.


Some tips

· Use the tools in the rightmost toolbar menu to zoom in or out. If you have a mouse wheel, try ctrl + mouse wheel to zoom.

· It is possible to alter the equation of the circle directly in the algebra window by double-clicking on it.

Example 6:  Equilateral Triangle
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1. From the Menu item View, hide the axes by selecting Axes from the drop-down menu.

2. 
[image: image37.png]


Construct a segment AB.

3. [image: image38.emf]Construct a circle with center A and through point B

4. [image: image39.emf]Construct a circle with center B and through point A

5. [image: image40.emf]Find the points of intersection of the two circles

6. 
[image: image41.png]


Construct segments AC and BC.

7. Hide the objects not needed.  To do this right-click (Mac OS: ctrl-click) on an object and select Show Object.

[image: image42.emf]Drag the vertices of the triangle and compare the lengths of the 3 segments.  Why cannot you not drag point C?

Example 7:  Investigating Angle Relationships

Task:  We will investigate angle relationships for two parallel lines cut by a transversal.
1. Open a new window.

2. We won’t need the Algebra window or the Axes for this example.  So, make sure these are not checked in the View Menu.

3. [image: image43.png]


  Construct a line 
[image: image44.wmf]AB

.
4. [image: image45.png]


  Construct Point C (not on 
[image: image46.wmf]AB

).

5. [image: image47.png]


  Construct a line parallel to 
[image: image48.wmf]AB

 through point C.

6. [image: image49.png]


  Construct the transversal
[image: image50.wmf]CA

.

7. [image: image51.emf]     Use the Move tool to make sure that the lines are attached to the points.

8. [image: image52.png]


  Construct points D, E, F, G, and H

	9. [image: image53.png]


 Use the Angle tool to measure the 8 angles.  

· Notice:  the order in which you select the vertices makes a difference.  

· Change the properties of each angle to show the value only.  To do this, right-click (Mac OS: ctrl-click) on the angle, select Properties from the drop-down menu, and select Value from the menu options for Show Label.
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	10. [image: image55.emf]  Move points A, B, and C and 
[image: image56.wmf]CA

 to see which angles stay congruent.

	Here is an example from a GeoGebra file that followed the steps above.
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Example 8:  Investigating Angle Sum of a Triangle 

Task:  We will observe the angle sum for a triangle is 180 degree.  We will then prove this observation using GeoGebra.

1. Open a new window.  In the View Menu, make sure the Algebra Window is selected and the Axes is not selected.

2. 
[image: image58.png]


  Construct triangle ABC, using the segments tool.  Right-click (Mac OS: ctrl-click) on each segment and de-select the label for each line segment.

3. [image: image59.png]


  Measure the three interior angles of the triangle.  Change the properties on each angle to display the Name and Value.
4. Calculate the sum of the three angles by typing in the Input field:  Sum = 
[image: image60.wmf]g

b

a

+

+

.  To get the Greek symbols you select to symbols from the drop down menu at the bottom of the screen (to the right of the Input field). 

5. [image: image61.emf] Drag the vertices of the triangle to observe the sum in the algebra window stays constant.
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Proving the observation
6. [image: image63.emf]Construct a polygon over the triangle.

7. Hide the label on the side by right-clicking (Mac OS: ctrl-click) on each segment and de-select the Show Label from the menu.
8. [image: image64.png]


Construct the midpoints of 
[image: image65.wmf]AB

 and 
[image: image66.wmf]AC

.

9. [image: image67.png]


Construct a line through A parallel to 
[image: image68.wmf]BC

.

10. We will now create an image of the triangle that has been

rotated about the midpoint D using a slider.


[image: image69.png]


Construct an angle slider.
· Select the slider tool and then click anywhere 

in the Geometry Window. 

· Select Angle from the pop-up window.

· Change the increment to 5 degrees.

11. [image: image70.png]


Rotate the triangle about each midpoint by the slider.

· Click on the interior of the triangle and point D.  A dialog box will appear and ask for an angle.  Delete the default value of 45 degrees and select 
[image: image71.wmf]d

from the drop-down menu with the Greek symbols.

[image: image72.png]Rotate object around point by angle

Angle
Jo FEl: >

& counter clockwise

© clockwise

gy | cancel






12. [image: image73.emf]  Move the slider to investigate the change.
You can change the color of the rotated image, 

by right-clicking (Mac OS: ctrl-click) in the 
interior of the image triangle and selecting 
Properties from the drop-down menu.

13.  Construct another angle slider to rotate the 

original triangle about midpoint E.  Repeat steps

10, 11 and 12.

Here are a couple of screen shots.  We can see in the picture on the right that the three interior angles of the triangle form a straight line, 180 degrees.  This should be a sufficient visual proof of the triangle sum theorem.


Example 9:  Derivative and Tangent of a Function

Task:  Use GeoGebra to construct the function f(x) = sin(x), its derivative and its tanget to a point on f plus the slope triangle.

[image: image74.emf] 

1. Insert the function f(x) = sin(x) into the input text field and press the enter key.
2. [image: image75.emf]Choose the mode “New Point” and click on the function f. This creates a point A on f.

3. [image: image76.emf]Next choose the mode “Tangents“ and click on the point A and the function f.

4. Change the tangent’s name to t (right-click (Mac OS: ctrl-click), “Rename”).

5. Type the command s = Slope[t].

6. [image: image77.emf]After choosing the “Move” mode, drag the point A with the mouse and observe the movement of the tangent.

7. Type B = (x(A), s) and switch on the trace of this point (click on B with the right mouse button (Mac OS: ctrl-click)). Note:  x(A) gives you the x-coordinate of point A.

8. [image: image78.emf]Choose the mode “Move” and drag A with the mouse – B will leave a trace.

9. Type the command Derivative[f].

Some tips

· Insert a different function, e. g. f(x) = x³ - 2x² into the input text field; immediately, its derivate and tangent will be displayed.
· Choose the “Move” mode and drag the function’s graph with the mouse. Observe the changing equations of the function and its derivative.
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